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1. Introduction

SeasStar is supporting software for the Starmon mini temperature recorder. SeaStar
can run under versions newer than Win 2000. This manual takes you step-by-step
through the hardware connections and use of the SeaStar Program.

Free upgrades of SeaStar are available at:
http://www.star-oddi.com/Online-Support/Software-updates/.

Please note that the downloaded file has to be installed into the existing SeaStar
folder. The update alone is not a complete program and therefore will not work like
that. Follow the instructions on the update website for correct installation.

This manual guides the users of Starmon mini through the operation of the recorder.
Setting the operating parameters as well as data retrieval requires access to a PC
computer with a standard RS-232C serial interface or USB.

Starmon mini is a compact microprocessor-controlled temperature recorder with
electronics and probe housed in a strong waterproof cylinder made of either plastic or
titanium. The plastic housing allows for an external pressure of 40 bars, which equals
a depth of approximately 400m. The titanium housing has a pressure tolerance of
1100 bar (11000m).

The serial name of the recorder is T-nnnn. nnnn is a four-digit number.

The recorder is powered by a small 3.6V lithium battery. The battery can be replaced
with the use of a soldering iron. The recorder can be sent to Star-Oddi for battery
replacement and recalibration.

Starmon mini is calibrated at Star-Oddi, and each recorder has its calibration
constants stored in its internal memory. It is recommended that the recorder be
recalibrated every 1-2 years.

The installation program is on the SeaStar CD. Insert the CD into your compact disc
drive. To install the program, follow the automatic InstallShield Wizard. Follow the
instructions on the screen. You will be prompted for a directory name for your
SeaStar program.

To uninstall the program, do the following:

Click on the Start button in Windows.

Go to Settings and Control Panel.

Choose Add/Remove Programs.

Choose SeaStar and click on Change/Remove, and ‘Yes to all'.

PoODNPE
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2. Preparation

This chapter describes preparations that should be carried out before connecting to
the recorder.

Start SeaStar and the following window will appear.

€ SeaStar5.16- S mini - C: mini\ [E=EEES)

File Edit Recorder Settings View Wizards Window Help

| [ [ [Com1 | 2

Figure 2.1 SeaStar main Window

Before connecting to the recorder, it is important that the clock on the PC computer is
correct. This is important since the recorder automatically downloads the PC clock
settings.

2.1 Select Recorder Type

SeaStar is compatible with other Star-Oddi instruments. A recorder type must be
selected before connecting to the recorder. The default setting in the software is set
to Starmon mini as a recorder type. Change the recorder type to Starmon mini by
doing the following:

1. Choose the File menu and the New Recorder Type command.
2. Select Starmon mini as a recorder type.

©2013 Star-Oddi. All Rights Reserved Page 6
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SeaStar - Select Recorder Type &J

Available Recorders:

Starmon mini LJ

Cancel

Figure 2.2 Select Starmon as Recorder Type

2.2 Configuration of the Communication Port

It is necessary to define which serial port on your PC computer you will use for the
communication cable. This is done the following way:

1. Choose the Communication command in the Settings menu. The
Communication definition dialog box appears.

2. Select a serial port for communications.

3. Choose the OK button.

() Communication Definition o | B .

Select communication port

(¢ COM1 " COM4

" COM3

Port enable / Power :
f« ON
" OFF

0K

Figure 2.3 Communication Port Configuration

Before connecting to the recorder, it is important that the clock on the PC computer is
correct. This is important since the recorder automatically downloads the PC clock

settings.

The user is also advised to view the Settings menu, to insure that the data directory
and data format are according user's requirements. The Settings menu is described in
detail in chapter 7.
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To check which communication ports are available on your computer, open your
Device Manager. On Windows XP you can do it following way: Control panel >
system > hardware > device manager.

Under Ports you can view all available ports. Make sure that the port you are intending
to use is enabled: right-click on the appropriate port and select properties. Under
‘Device usage’ it should state ‘use this device (enable)'.

2.3 Using the USB Serial Converter

If you are using the USB serial converter you will need to install the driver first that
comes on the provided CD. Please read the Quick Installation Guide' booklet to get
further instruction on how to proceed.

After you plug in the USB cable you will see a new communication port in your device
manager, called ,Prolific USB-to-Serial Comm Port'. Make sure that the port is
enabled and select the appropriate port in SeaStar.

L. Device Manager

File  Action Wiew Help

mEE 2 A =Ra

+ _J Computer s
+|-agn Disk drives
+ :_j Display adapters
+ ik DWDJCD-ROM drives
+-[38 Human Interface Devices
+-i=) IDE ATAJATAPL contrallers
- Keyboards

Mice and other pointing devices

j Manitars

+ ﬂ Metwork adapters
= 5 Parts (COM & LPT)

(y Communications Pork (COM1)

. ECP Printer Part (LPT1)

’ i InteI(R) Active Management Technologv SOL (COM3)

rolific LSB-ko-Serial Com Yark (i

+-%#98 Processors
+-@), Sound, video and game controllers

+ System devices
+] Universal Serial Bus controllers v

Figure 2.4 USB Communication Port in Device Manager
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3. Hardware Connections

This chapter provides details concerning the communication cable and how to
connect the cable to the recorder.

3.1 Communication Cable

The Starmon communication cable is an RS-232C compatible cable, specially
designed to communicate with Starmon recorders. The cable will feed power to the
recorder while communicating with the PC. A USB serial converter cable is also
available.

If the battery inside the recorder is dead, the PC and cable are still able to connect to
the recorder and retrieve data.

3.2 Connecting

Unscrew the end cap on Starmon mini. The socket becomes accessible as shown in
the following figure:

Figure 3.1 Connector Socket under the Cap

Connect the communication cable between the serial port of the computer and the
socket inside the recorder.

When data upload is completed and/or new measurement settings have been
downloaded to the recorder, the user should disconnect the recorder and close the
housing. It should be adequate to tighten the cap firmly by hand. Occasional
lubrication of the o-ring seal is recommended.

©2013 Star-Oddi. All Rights Reserved Page 9
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3.3 COM Connection

) Communication Definition = | B .

Select communication port

(+ COM1 " COM4

" COM3

Port enable / Power :
+ ON
" OFF

0K

Figure 3.2 Communication Definition

Choose Settings-Communication-Serial Ports to display available ports (see figure
3.2). Com ports up to COM255 can be selected.

3.4 Com Port Wizard
Com Port Wizard @

COM1 [
Iz the StarlCom cable connected to this port? 9

- 4

T

Figure 3.3 Com Port Wizard

Choose Wizards- Com Box Connection to enter the Com Port wizard (see figure
3.3). The wizard goes through available ports and activates them one at a time and
asks the user to confirm that the communication cable is connected to a specific port.
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4. Using Starmon mini - Tutorial

This chapter guides users through the process of utilizing SeaStar to set up Starmon
mini prior to recording and data retrieval.

4.1 Starmon mini Set Up

Step 1 - Start Program

Start the SeaStar software. Remember to carry out the software preparation outlined
in chapter 2.

Step 2 - Connect

Unscrew the end cap on Starmon mini. Connect the communication cable between
the serial port of the computer and the socket inside the recorder.

Step 3 - Connect to the Recorder
Choose the Recorder menu and the Connect command. The window in figure 4.1

appears.
Connecting and Retrieving ID

Connecting to recorder 1 (1]
Retrieving recorder EP-ID..  OK
Testing recorder EP-ID for type.. 0K

Confirming type & version.. 0K
Retrieving recorder RID.. 0K
Making CRC test.. 0K
Created recorder data-directory:
E:A\Testh71a8015UPYIS179

Making the MED file.. 0K
Retrieving RAM data.. 0K
Making the MRD file.. (1]
Testing power-down.. (1]
Reading Clk-data 0K
Making the RID file.. oK
Making the RIT file.. 0K
Making the RCI file.. 0K

Fez

Figure 4.1 Connecting and Retrieving
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Once the connection has been established, a window appears with information on the
recorder’'s mode (see figure 4.2).

Connection OK @

L o o
The recaorder iz onine
The recarder was in sleep mode

ok

Figure 4.2 Connecting to the Recorder

Press OK. The Recorder is now on-line, as indicated at the bottom of the SeaStar
window.

SeaStar checks which version of firmware is in the recorder. If the software does not
recognize the firmware the user will be asked to update SeaStar as there might be a
new functionality in the firmware which SeaStar does not support.

Connection time registration

Each time SeaStar connects to a Recorder, the PC time and recorder time is
registered to a binary file, with a CLK extension. This information is also saved to a text
file with the extension CCT.

Another text file is created with the extension CCD, containing various information, for
example on previous connection and time comparisons, depending on the status of
recorder.

If a previous CCT file exists and the recorder was in sleep or slumber mode, a PC vs.
recorder clock comparison is calculated, indicating difference in seconds and ppm.

If the recorder was in measurement mode, then a drift calculation is performed, based
upon PC-time comparison to the recorder's clock and measurement sequence.

The RIT file contains partly the same information as the CCD file.

Upon retrieving date from a recorder and converting the data, the last measurement
retrieved time and the next scheduled measurement time is compared to the PC time.
The results are added to the CCD file and the MIT file.

Note: If the retrieved number of data does not match the last measured number of
data, erroneous results are to be expected.

Step 4 - Set New Measurement Parameters

(If the recorder has already been set up to record data and you want to retrieve data,
go directly to step 6).

Choose the Edit menu and the New Measurement Sequence Definition command.
The following window appears:

©2013 Star-Oddi. All Rights Reserved Page 12
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() Set New Measurement Sequence I =AEcl X

Set start time

Start date: 9.11.2010 v
Start time: Hour 14 v| Min 32 e

Set measurement interval time

Hours 0 v
Minutes ;0 :
Seconds 10 v

Set Mode

Use Template
¢ Single mode
Use Default

i

" Multi mode -
Previous

L

[ Save this NMS definition as a Template [file)

oK ] T Canca

Figure 4.3 Measurement Sequence Definition

Select the start time of recordings (date-month-year, hours-minutes). The start time
of the new measurement sequence must be set at a minimum of three minutes in
advance. Set the sampling interval (hours-minutes-seconds).

If the user wants to program many recorders with the same sampling interval and start
time, it is recommended to select Multi mode. By choosing Multi mode, the settings
are fixed; giving each recorder connected to thereafter, the same settings. The
recorders that are connected to, following the first recorder, automatically get the
same settings as the first recorder. This saves time in the programming process. The
multi mode can be deactivated by clicking Cancel when connecting to the recorder
(see figure 4.4).

x

/ 9 The recorder “s new measurement sequence settings are:
| |

—  Start time: 17.5.2011 16:50:00
Measurement interval [hms]: 00:00: 10

Cancel l

Figure 4.4 Multi Start Mode
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The three buttons Use Template, Use Sequence, and Previous are not commonly
used. They can be used when one wants to use a previously programmed sequence.
The Use Template can be used if older definitions have been saved by enabling the
‘Save this NMS as a template (file)'. That way it's possible to get templates that have
been set up in the past. With the Use Sequence button it is possible to get same
settings as from other recorders, by browsing for their serial no. By hitting the
Previous button the settings go back to previous, before changes were made. To read
more about templates see chapter 7.

After the settings have been selected, press the OK button.

Step 5 - Start a New Measurement Sequence

To set the recorder in Measurement Mode (start recording), choose the Recorder
menu and Start New Measurement Sequence command. The window in figure 4.5

appears.
Start New Measurement Sequence

Figure 4.5 Start New Measurement Sequence

Once the new measurement sequence has been downloaded into the recorder, a
window appears on the screen in order to verify the settings (see figure 4.6):

S5tart New Measurement Sequence Activation |E
-

The recorder’s new measurement zequence settings are; b )

Start time: 02/06/2009 14:31:50
 eazurement interval [hmz): 00:00:10

OF. [ Cancel ]

Figure 4.6 Start New Measurement Sequence

Press OK and the recorder will be set in Measurement Mode.

©2013 Star-Oddi. All Rights Reserved Page 14
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NMS Calculation

Upon setting up a NMS the estimated measurement sequence is calculated and
memory and battery energy usage predicted. The results are written to a text file,
bearing the recorder name with a NMS extension. If a recorder has not been selected

then the file bears the recorder type name, still the NMS extension.

An example of the *NMS file is shown in fig. 4.7. The file is placed in the

SeaStar\NMS directory.

Seadtar 4.3
File creation Date & Time

¢ 0670772008 08:59:46

Recorder type
Recorder wersion
Recorder mmber
Recorder measures
Recorder memory(byte/meas.):

¢ Starmon mini
HE

¢ TZ93d

: Temperature

524063 7 349375

Eatimared time duration and

battery usage for NM3

Measurement starts
Battery energy at start (%)@

: 06/07/2009 10:59:00

1o00.0

Cycle 1

Seq/Inr DatesTime
1/1 17/08/2009 04:59:00
2/2 08/11/2009 16:59:00

Cycle 2

Seq/Inc DatesTine
1/1 Z0/12/2009 10:59:00
2/2 13/03/2010 22:59:00

Cycle 3

Seq/Inc DatesTine
1/1 24/04/2010 16:59:00
2/2 17/07/2010 04;59:00

Cycle 4

Seq/Inc DatesTine
1/1 Z7/08/2010 22:59:00
2/2 18/11/2010 10:59:00

Batt.used(%) Mem.usedi%)
1 0
Batt.used(%) Mem.usedi%)

1 i}
2 1

Batt.used(%) Mem.usedi%)
2 1
3 1

Batt.used(%) Mem.usedi%)
4

4 2

~

Filename: C:\SeaStar\NM3\T2934.HM5

Heas. taken
Tenp
100z
z004

Heas. taken
Tenp
3006
4008

Heas. taken
Tenp
s010
&s0lz

Heas. taken
Tenp
7014
&0l6

Figure 4.7 Results from NMS Calculation

When starting the recorder in a NMS, the *.RDT file now shows the sequence
settings, plus information on the sequence time duration and battery usage (same as

in the *NMS file).

Step 6 - Retrieve Data

Choose the Recorder menu and the Retrieve Data command. The following window

appears:

©2013 Star-Oddi. All Rights Reserved
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Retrieve Data from Recorder

Retrieving recorder 1D.. oK
Testing ID.. oK
Retrieving data.. oK
Making the 1. MIT file.. oK
Converting the data.. oK

Bytes received: 5000 of 5000
Time (min:sec): 0:47 of 0:52
Packs received: 20 of 20
Resent packs: 0

Receive errors: 0

: Cancel data retrieval :

Figure 4.8 Retrieve Data from Recorder

The window in figure 4.8 shows the data retrieval progress in bytes, time elapsed and
number of packs received.

Data will be uploaded from the recorder and presented in graphical and tabular form.
With default settings, SeaStar automatically creates a sub-directory in the ‘SeaStar’
directory, named ‘Starmon mini'. In the ‘Starmon mini’ directory, a directory named
after the recorder’s serial number (Tnnnn) is created. All files related to the recorder
are automatically saved in the serial number directory. The default data directory can
be viewed in the Settings menu, and Directories. The user has the option to define a
new data directory path if desired.

The data is retrieved in a non-destructive manner. This means that you can repeatedly
read the data without erasing it from the memory. Each time data is retrieved, a new
file will automatically be created. The name of the data file consists of the
measurement sequence number and the serial number of the recorder. The recorder
cannot be loaded with new settings if it contains data that has not been retrieved. This
is a safety feature which prevents data from being accidentally lost.

After data retriaval, the recorder can be set up to measure again, or it can be put into
Sleep Mode.Minimum power is depleted from the battery while the recorder is in
Sleep Mode. When the recorder is on-line, the user can put it into Sleep Mode by
disconnecting the recorder, or by choosing the Recorder menu, and Put Recorder in
Sleep Mode. To set the recorder in Measurement Mode, repeat steps 3, 4 and 5.

©2013 Star-Oddi. All Rights Reserved Page 16
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Step 7 - Disconnect

Disconnect the cable and close the housing. The cap should be tightened firmly.
Occasional lubrication of the O-ring seal is recommended.

Note that the old types of Starmon (up to serial no. 549) don't go into sleep mode
when being disconnected from the computer but will continue consuming battery. To
put your Starmon into sleep mode select Recorder > Disconnect.

Step 8 - View Data

When data is retrieved from the recorder, a new file will automatically be created and
opened in graphical and tabular form. To open existing data files on the computer,
choose the File menu, Select Recorder command, and then the Select Measurement
command. When a data file has been opened, a new window appears with the data
shown as a chart and a table. The next chapter will describe in detail how to view and
process data.

©2013 Star-Oddi. All Rights Reserved Page 17
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5.View Data

This chapter describes how to open a data file and the options available in SeaStar for
viewing the data.

5.1 Open Data
To open an existing data file that has already been retrieved, do the following:

1. Choose the File menu and the Select Recorder command. When a recorder
has been selected, its serial number will be displayed in the blue top bar of the
software.

2. Select the data file by choosing the File menu and the Select Measurement
command.

The name of the data file consists of the number of times the recorder has been set up
to measure plus the serial number of the recorder. When the data file (.mid) has been
selected, the chart and data tables are opened. The following figure shows a chart
and data table which have been opened:

EeEll=E / H Templates Hide Table
3T2934DAT-Reconverted- Time linear ad;. Mumber Tirne Temp(*Cl| #

0/08/2005 12:01:00 23.72
0/05/2005 12:02:00 23,72
06/02(2003 12:03:00 23.72
0/05/2005 12:04:00 23,72
06/02(2003 12:05:00 23.71
0/05/2005 12:06:00 23,71
06/08(2003 12:07:00 23,71
0/05/2005 12:08:00 23,71
10 | 06/08{2005 12:09:00 23,71
11| 06/05/2008 12:10:00 23,71
12 | 06/0&{2005 12:11:00 23,71
13| 06/05/2003 12:12:00 23,71
14 | 06/05{2005 12:13:00 23,72
15| 06/05/2003 12:14:00 23,72
16 | 06/05/2003 12:15:00 23,72
17 | 06/05/2003 12:16:00 23,72
18| 06/05/2008 12:17:00 23,73

=N T TR N

I Y
)

T T T T
01.09 00:00 0110 00:00 01.11 00:00 01.12 00:00
Meazurement time: 06082008 - 1:31 2/2008

v

Time-Window Statistics for Temperaturel>C)
Max: 299 at 07.08 15:09 Min: -1.77 at 27.08 00:24 Average: 19.5 | | e | om

Figure 5.1 Chart and Data Table of an open File

At the bottom of the SeaStar window you can view the measurement sequence
number, which indicates the number of times the recorder has been set up to
measure.

5.2 Import

Data files from other recorders than Starmon can be imported into SeaStar and
viewed as charts and tables. The imported file must be a text file with the extension

©2013 Star-Oddi. All Rights Reserved Page 18
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DAT, and with SeaStar's conventional DAT file structure. See more about data files
and headers in the Appendix.

5.3 Buttons

When the chart is opened, buttons related to the chart are displayed.

2

Active Series List

This button can be useful when working with a multi-sensor recorder, in order to
select which parameters to display in the chart. Click the button and the following
window appears:

r B
) Series List ﬂl-ﬁ:—hj

}ﬁ [P Termperature(’C|
@ [T — TimeLine

0K I
Only show

[~ active table
columns

Figure 5.2 Series list

By selecting Only show active table columns only the selected series will be
displayed in the chart table.

©2013 Star-Oddi. All Rights Reserved Page 19
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The table columns can also been changed manually by right-clicking on the table (see
figure 5.3).

Number Time Temp(°C)|
.| 18.5.2007 16:20:00 | 27,702
3 ¥ Number
: 4 v Time
= 5 v Temp(*C)
O OTITZOUTIOTZUTIOTEY;

Figure 5.3 Table

Horizontal/Vertical Gridlines
These two buttons give the option of hiding/displaying the horizontal/vertical gridlines
in the chart.

A drop-down menu appears when clicking the horizontal gridlines button.
Off
v Temperature(*C)

Figure 5.4 horizontal gridlines

Select the series gridline.

©2013 Star-Oddi. All Rights Reserved Page 20
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A drop-down menu also appears when clicking the Vertical gridlines button

Off

@ Auto
Minute
Hour
Day
Menth

Year

Figure 5.5 vertical gridlines

Select the minimum grid size.

#|

Data Point Marker
This button gives the option of displaying/hiding data points in the chart.

Histogram
The chart can be shown as histogram, displaying the distribution of values by
percentage.

Click the Histogram button and the following window appears:

Histogram and data statistics
Select Bin Settings
Temperature(°C) .
90% | « Default
" User
80%
70% ,:'7
€0%
€ so% fom
£ o
S 40%
a
30% i
20%
10%
0% - T T
28.047 - 28.720 29.392 - 30.085 30.737 - 31.410
Data Statistics
Min: 28.047 Max: 31.410 Range: 3.363
Mean: 28.367 Median: 28.191 Points: 6424
Std. Dev: .555 Variance: .308 Mode: 28.104
Print

Figure 5.6 Histogram and data statistics

©2013 Star-Oddi. All Rights Reserved Page 21
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Under Bin Settings there are two options, Default and User. Choose User to select
the number of bins and the minimum and maximum values you wish to display.

The Histogram can be printed out by clicking the Print button.
=

Save Window Data

Retrieved data is automatically saved, but if changes are made with the graph, for
example with the time scale, the save button enables the user to save the graph (as a
DAT file).

Print Chart
The chart can be printed. For more details see chapter 6.Printing.

&

Zoom Out

Click this button to zoom out the chart.

»

Zoom In
Click this button to zoom in on a previous view.

A

Adjust Axis

This button adjusts the axis in order to display all data within the zoomed timeline.

Open file in PatternFinder

Click this button to transfer data to PatternFinder

©2013 Star-Oddi. All Rights Reserved Page 22
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Chart Edit
By clicking this button, the following window appears:

I Series TimeLine A @ Line: TimeLine
Temperature(C)
Faormat ]Pgint ]
—|- Chart )
+- fxis Border,..— | [ Dark 3D Ui Mctde.
+- Titles I B
Legend Color... [ Calar Each [ Inverted
Panel
Paging Pattern... v Clickable Outline
+-Walls —
Data Height 30 |0 =l v Calor Each line
= =T
+- Tools
Expark Stack:  Mone - Shadow, ..

i

Treat pulls:  Donk Paink - Gradient.. [ ]

Close:

Figure 5.7 Editing Chart

This button gives several options regarding the look of the graph. The axis can be
defined (max. and min.), titles and legend can be set visible. Under ‘Panel’ the color of
background, borders and gradient can be selected. Under ‘Walls - Back'’ the colors
and gradient of the graph itself can be selected. The ‘Visible’ option must be enabled
to activate the features. The graph can be exported in formats as jpg, gif, bitmap,
metafile, pdf, htm and svg.

Templates

Templates
If the changes have been made to the graph under ‘Chart Edit’, it is possible to save
that template. It is also possible to load a previously saved template.
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iy Display table completely

~8
Partial table display

o Hide table

5.4 Using the Mouse

Min and Max Values

Click once on the temperature line in the chart, and the maximum and minimum values
are shown. A straight vertical line should be visible in the graph (to the left). By
clicking on this line and holding the left button on your mouse down, the line can be
dragged through the chart and the data-table will scroll along with the position of the
line.

Zoom
The chart can be zoomed in on by holding down the left button of the mouse, and
using the cursor to create a box to the right, around the desired area to zoom in on.

Scroll the Chart
The chart can be scrolled upward, downwards and to the sides, by holding down the
right button of the mouse and moving the cursor in the desired direction.

Go Back to Initial View

To go back to the initial view of the chart, simply hold down the left button of the
mouse and make a box to the left with the cursor. The position of the box on the chart
is irrelevant.

Change the Axis
By double clicking on the X and Y-axis, the measurement time and temperature range
can be changed.

Change the Title
To change the title of the chart, double click on the title of the chart.

5.5 The View Menu

When a recorder has been selected, the files in the View menu can be opened.

Data Trend and Table

This view is automatically selected when data is retrieved or a data file is opened. If
the chart is closed, but a recorder has been selected, this command can be selected
to view the chart. The software will open the latest chart that was viewed for that
recorder.
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Recorder Information (RIT)

This is a text file containing basic information about the recorder, serial number,
production date, estimated battery life etc.

Recorder Calibration Information (RCI)

This text file contains information about the calibration constants of the recorder,
calibration range of the parameters. The range is both showed as decimal values (DV)
and unit values (UV). The survival depth of the recorder is also shown.

Recorder Download Information (RDT)

This text file contains information about the measurement sequence that was last
downloaded into the recorder, including the start time, sampling interval and the
measurement sequence number.

Viewing Text Files

Under <View\Text files> the user can select a text file, via a file browser, for viewing.
This option is meant to give the (advanced) user a chance to view files that are not
directly supported for viewing in SeaStar, but are a part of the SeaStar
documentation system.

The files that the file browser accepts must have the following extensions:

o TXT
Frequently, users copy SeaStar data to text processors and spreadsheets, like
Word and Excel, and later save the data as TXT files for viewing in other
applications.

e INI
There are a number of INI files that SeaStar uses for store settings. These files
are described in the Appendix under ‘Information files’. The latest members in
the INI files family are the Template files.

e DAD
This is the original data file. It contains the raw data (in Ascii format) retrieved
from recorder. The DAD together with the MID are converted to the DAT file.
A word of warning: The DAD file should never be tempered with, as that might
give cause to erroneous data conversion.

o CCT
Every time SeaStar connects to a recorder, the PC time and the recorder’s
clock data are stored in a <recorder name=>.CCT file.

e CCD
Every time SeaStar connects to a recorder, the PC time and the recorder’s
time are compared to the last CCT, if found, and stored in <recorder
name>.CCD file, <measurement sequence name>.CCD.

e NMS
Upon completion of a NMS editing session, estimation of memory and battery
usage is calculated and the results placed in a NMS file, which is then
displayed to the user.
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SNMS LOG File

To improve the “Start New Measurement Sequence”, SNMS, indication/registration of
success or failure, a log file for each recorder type is placed in the SeaStar directory.
The log file name, for Starmon mini, is DSTT.LOG, i.e. the same naming convention
as for the type INI files.

Each time a SNMS is performed then the appropriate LOG file is updated.
The LOG file can be viewed via “View\SNMS Log file (LOG)".

In addition to the LOG file, if an error occurs during the SNMS, the MDD file is
created as a text file, with a description of what went wrong. This MDD file is
displayed as a clear message for the user (figure 5.8).Usually the MDD file is a binary
file, and the MDT is created from the MDD. If the SNMS is repeated successfully the
MDD file is overwritten and the MDT file created.

Fecorder numher oQonz?
Measurement sequence number : &
Attenpted SNMS Date and Time: 3.12.2006 15:44:17

4 communication error ocecured when
transfering new settings to the recorder

Please note that the recorder was NOT started !
Please try again.

Figure 5.8 The MDD SMNS Error Message

Measurement Data

Measurement Download Definition (MDT)
This text file contains information on data downloaded into the recorder for the
measurement file being viewed, including the start time and sampling interval.

Measurement Information (MIT)
This text file contains information concerning the measurement upload time, start date,
start time and number of measurements in the measurement data file.

Conversion Information (CIT)
This text file contains conversion information on the units and the data file format.

Statistics in CIT:
The CIT, has been enhanced with more detailed information on the converted data.

As can been seen in figure 5.9, the statistical data, that have been tabulated, are split
into two sections, the Unit values statistics and the Decimal value statistics. Values are
given for each parameter. The file can be viewed under ‘View\Measurement
Data\Conversion Information (CIT)'.
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A one line description/comment is available for the user to fill out in the Reconvert
data menu. This description is placed in line two of the CIT file.

C:\DOCUMENTS AND SETTINGSVALL USERS\DOCUMENTS\SS-DATANSTARMON MININT2420M T2420.im (= |[B1](5¢]

| Filename: C:h%Seadtar’\itarmon mini‘TZ420%1T2420.CIT -

Description:
Recorder type : Adtarmon mini
Recorder number i Tadzn
Recorder wersion P17
Recorder measures : Temperature
Mewmory capacity : 349364
Measurement sedquence humbher HE N
Convertion numher H |
Meas. start time[d.w.¥ h:m:s] : 05.05.07 16:17:19
Time of conwersion D 8.5.2007 16:28:28
Conwversion type : Upload conwersion
Calibration constants used : from MID-file
Humber of measurements H
Measurements read from DAD 51
Converted measurements 51
Data file settings
Temperature unit : [°C) Celeius
Temperature number of decimals : 3
Mo Tewperature offset adjustment
Decimal point : , lcomma)
Date format : [mdy] (month day year)
Date separation : / (=lash)
Time separation :: {colom)
Field separation : Tab
Out 0f Range DV (Decimal ¥alue) Limits
RID: Tewmparatur Calibration limits: 204 - 3772

I Out 0f Range UV (Unit Value) Limits (User Def.)
______ R e 2

Figure 5.9 Statistics in CIT File

Out of Range (OOR)
This text file shows the number of measurements recorded that were outside the
calibration range.

Binary Data (DAB)
This file contains raw data of the measurements in the data file. Calibration files are
not calculated into the data.

View DAB Files as Trend

When converting the DAD -> DAT the DAB file is created simultaneously.

The DAB shows the recorder’s native data, i.e. decimal values in the range 0-4095.
These values originate from the recorders 12 bit ADC (Analog to Digital Converter).
It can be of interest to view the data in its native form, for example to spot
saturation/out of range intervals.

The DAB can be viewed graphically as a trend via:
‘View\Data Trend and Table\Decimal (Binary) data (DAB)’
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Figure 5.10 DAB Trended

SeaStar cannot view older DAB files, and will inform the user to that effect, if an
attempt to view an older DAB file is performed. By reconverting the data, a viewable
file is produced.

Binary Pressure Temperature Corrected Data (BPD)
Pressure measurement circuitries are calibrated against measurement errors due to
temperature changes.

Raw decimal values from the recorder can be seen in the DAB file. The first step in
converting decimal values to unit values is the circuitry temperature correction. The
result of this first correction can now be seen in a new file in SeaStar, *.BPD. The file
contains the corrected decimal value and the difference between the original value
and the corrected one.

The file can be viewed graphically or as tabulated lists.

Converted Data (DAT)
This is the text file for the converted data. The DAT file as well as the other text files

can be opened in other programs (Excel, Notepad, Word etc.).

Time Synchrone Data (TSD) and Rate of Change (ROC)

If the TSD and/or ROC file creation has been enabled under the Settings menu, then
it's possible to view these files. More information about TSD and ROC can be found
in chapter 7.
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Online Measurements

It's possible to view measurements from the recorder online (Recorder\Online
Measurements). If the recorder has been set up for online measurements, then it's
possible to view the last (current) sequence or select a previous sequence.

More about files in the ‘Appendix’.

SeaStar Log

SeaStar stores events in the file <SeaStar.log>. The events are:

e Recorder Connected

e Retrieving data from a recorder

e Uploading a measurement sequence to a recorder

e Recorder disconnected.
This file can be opened in SeaStar under <View/SeaStar Log> or by opening it with a
text editor.

Screenshots

By pressing the Print Screen keyboard button while in the application a screenshot of
the desktop is taken and stored in a subfolder, Screenshots.

The user can name the screenshot file as can be seen in the following figure.

Screenshot E‘

Set filename

|My5-:reen5h-:ut

| Ik | Cancel |

Figure 5.11 Name the Screenshot

The screenshots can be viewed in View-Screenshots or by browsing the screenshot
folder, <\SeaStar\ScreenShots\>.

The button also performs its normal operation which is to store the screenshot in the
clipboard.
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5.6 Opening Data in Excel

When retrieving data, the SeaStar software automatically creates a text file with the
data, called *.DAT. This text file can be opened in Excel and in other programs.

Joined Date and Time

Under the ‘Settings’ menu, ‘Preferences — Data File Format’, the default factory
settings is set to ‘joined date and time’. If this option is not disabled, the following is
performed, for opening data in Excel:

1. Excelis started.
2. The *.dat file is found from ‘File\Open'.
3. Excel comes up with the ‘Text import wizard'. This is a three step process:
a. No changes should be made in first step, so hit the next button.
b. ‘Text qualifier’ should be set as ‘None'. Hit the next button.
c. Column 2, that is date and time, is set as ‘Text'. Hit the finish button.
4. You can now create the graph with columns B and C.
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6. Printing

All charts and text files can be printed from the SeaStar software.

6.1 Charts

Open the chart you want to print out and select File-Print on the menu bar. The
following window appears:

= T . 3
{) TeeChart Print Preview =NE=

Printer: HP Laserlet 2420 PCL S5e v Setup... Print | Close I

TtOriengaﬁon: -
" Portrait

(% Landscape

‘;Margins (%)~

e
‘ o o iy
15 = s 5 ,=

wamuROZAE
WRHRHHRN RN RN

v View Margins

Detail:
| More Normal

——

[V Proportional
[~ Smooth

Figure 6.1 Print Preview

Orientation
The chart can be printed in either portrait or landscape format.

Margins

By changing the margins, the chart’s length and width can be re-scaled. The margins
can be varied by either changing the numbers given for the left, right, top and bottom
margins, or by moving the margin lines with the mouse by pressing and holding the left
button as the lines are dragged.
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Move

When the cursor is located on the chart, a hand becomes visible. By clicking on the
chart and holding down the left button of the mouse, the chart can be moved around
the page to a desired position.

Details

The size of horizontal and vertical gridlines as well as the texts on the X and Y-axis can
be re-scaled by using the scroll bar. The number of gridlines is increased when the
bar is moved to the left.

Another way of printing out a chart is opening the chart you want to print out and
clicking the Print Chart button on the chart bar.

6.2 Histogram

To print out a histogram, open the chart which histogram you want to print out and
click on the Histogram button on the chart bar. The following window appears:

-
Histogram and data statistics @

Select Bin Settings

Temperature(°C) &+ Default

" User

Print

A
€ 50%-
£ I
© 40%
a
30%
20%
10%
0% — | = -
28.047-28.720 29.392-30.065  30.737-31.410
Data Statistics
Min: 28.047 Max: 31.410 Range: 3.363
Mean: 28.367 Median: 28.191 Points: 6424
Std. Dev: .555 Variance: .308 Mode: 28.104

Figure 6.2 Histogram
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Click Print and the window in figure 6.3 appears:

r =Ty
Qutput Options @

—Selected Printer
HP Laserlet 2420 PCL Se

—Report Destination | [y
" Printer Ok

{* Preview Cancel I
" File I L1

Format:lRa-.'e SﬂapshctFiIe«H[;l §etup |

—Options
Copies [T Collste

Figure 6.3 Output Options

To change the selected printer, click Setup and select another printer.

To see a preview of the print out, select Preview under Report Destination and click
OK (see figure 6.3 and 6.4).

-
&) Report Preview ==

File Page Zoom

S E G |I4 4 » Pl Page 1 ofl | & A = B Zoom|[iE % H

L) seaStar 25.10.10 13:58:21

Histogram and Statistics
File name: C:\SEASTAR\DST CENTI\C0503\1C0503.DAT

Time range: 13.4.2003 00:00:00to 3.12.2004 10:40:00
Measurements: 1to 86465

Temperature(°C)

©

=

®
L
m

1% —

2,402-7,489 12,536-17,602 22,669 -27,736

Data Statistics

Min: 2,402 Max: 27,736 Range:25,334
Mean: 5,636 Median: 5,298 Points: 86465
Std. Dev: 2,642 Variance: 6,979 Mode: 7,594

Figure 6.4 Report Preview
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6.3 Files

Activate the file you want to print out and select File-Print on the menu bar. The

following window appears:

7~

Qutput Options

—Report Destination
" Printer

¢ Preview
C Fil

Format:lRa‘.‘s Snapshot File mij

Selected Printer
HP LaserJet 2420 PCL Se

Options
Copies [535C

[ r

Figure 6.5 Output Options

The dialog window in figure 6.5 has the same functions as the one in figure 6.3.

Note that as some of the files are very large, it is recommended to highlight the data
you want to print out before printing.

) Report Preview

= | B

File Page Zoom

SEH$ e »

"l Page [1 ofl | | A = B Zoom [N % | B

() seastar

25.10.10 12:12:03

C:\SEASTAR\DST CENTIC0503\1C0503.DAT

#0 Date-time: 3.12.2004 11:50:55
#1 Recorder: 1€0503

#2 File type: 1

#3 Columns: 4

4 Channels: 2

#5 Field separation: 0

#6 Decimal point: 1

#7 Date def.: 0 1

#8 Time def.: 0

29 Channel 1:  Temperature(*C) Temp(°C) 3 1
#10  Channel 2:  Depth(m) Depth(m) 2 2
#11 Reconvertion: 0

1 13/04/03 00:00:00 16.276 0.30
2 13/04/03 00:10:00 16.158 0.26
3 13/04/03 00:20:00 16.039 0.23
4 13/04/03 00:30:00 15.921 0.19
5 13/04/03 00:40:00 15.832 0.40
6 13/04/03 00:50:00 15.742 0.13
7 13/04/03 01:00:00 15.653 0.34
8 13/04/03 01:10:00 15.564 0.31
9 13/04/03 01:20:00 15.475 0.28
10 13/04/03 01:30:00 15.385 0.25

Figure 6.6 Report Preview
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7. Settings

This chapter describes the options in the Settings menu. These settings are
automatically saved when exiting the program.

7.1 Directories

The path definition can be set as Default SeaStar path structure or User defined
paths. Choose the Settings menu and the Directories command. A dialog box
appears:

) Path Definition 1 = | =] -E&I

Set path definition as:

" Default SeaStar path structure

" User defined paths

Default SeaStar path structure

Data directory: C:\SeaStarhStarmon mini\Tnnnn

Type directory: C:\SeaStarhStarmon mini

User path definitiory

Data directory

L

I C:A\SeaStar\Starmon mini

Description |
E T [ Estaesomion |
¥ [ Ddte gty |

L

0K i Cancel |

Figure 7.1 Directory Path Definition

Default SeaStar Path Structure

With default settings, SeaStar automatically creates a ‘Starmon mini’ type directory
in the ‘SeaStar’ directory that was created when the software was installed on the
computer. After connecting to a recorder, another directory is automatically created in
the ‘Starmon mini’ directory, which is named after the serial number of the recorder. All
data files and other files related to that recorder are stored in this ‘serial number’
directory. Each Starmon mini recorder has its own data directory.

User Defined Paths

If this option is selected, the User definition data directory becomes active as shown
in figure 7.1. The data path/directory can be defined by the user. For defining a path
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on the network, the particular drive must be mapped (under Windows Explorer) in
order to browse for the drive under ‘Add data path’.

Create recorder directories
This option is default on, and means that a recorder type and serial number directory
is created for every recorder connected to.

Browse first in user directory

With default off, the user is first directed to the path where SeaStar was installed, to
look for the INI file for a particular recorder. If this option is enabled, SeaStar will start
looking for the INI file in the user-defined directory. More information on files and their
structure can be found in the Appendix.

7.2 Preferences

Units

By choosing the Settings menu, the Preferences command, and Units, a dialog box
appears:

.} Temperature Units l o= Iiz—J

Temperature units:

& Celsius [°C] Number of decimals(0-4):

" Fahisrbei [F] 3

.................................

oK Cancel

.................................

Figure 7.2 Temperature Unit Dialog Box

Select Units

The user defines whether degrees Celsius or Fahrenheit are used as a unit for
temperature measurements.

Select Number of Decimals
The user defines the number of decimals for temperature values displayed in SeaStar
and for text files that are created.
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7.3 Data File Format

By choosing the Settings menu, the Preferences command, and Data File Format, a
dialog box appears:

) Data File Format l%_J
Date format Date separation
& Dot []
(& dd mm yy
~
" rran A " Slash [/)
" Dash [
Time separation Field separation
& Colon[:) ¢ Tab
" Dot[.] " Space
Date and time column definition Select decimal point;
¢ Joined date and time ¢ Commal.)
(" Seperate date and time " Dot[.)
Cancel

Figure 7.3 Data File Format Dialog Box

Date Format
The user defines whether the date should be shown as dd mm yy (day, month, year),
or mm dd yy (month, day, year).

Date Separation
The user defines whether a dot, slash or dash should be used to separate the date.

Time Separation
The user defines whether a colon or a dot should be used for the time separation.

Field Separation
For the text files created, the user defines whether a tab or a space should be used to
separate the fields.

Date and Time Column Definition
If data is to be exported to other programs, it is recommended that the date and time
be joined in one column.
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Select Decimal Point
The user defines whether a comma or period is used for the values displayed in
SeaStar and for text files that are created.

Measurement Interval

The default setting in the software is set to ‘Single interval’, as most users utilize. By
choosing ‘Multiple intervals’ the software enables programming of several different
sampling intervals, enabling memory saving efficiency. By choosing the Settings
menu, the Preferences command, and then Sampling Intervals, the following dialog
box appears:

(.} Measurement intervals &J

MNumber of measurement intervals to use

" Multiple intervals

0K Cancel

Figure 7.4 Measurement Intervals

By choosing ‘Multiple intervals’ the effects are shown in the dialog box that appears
when you choose the New Measurement Sequence Definition command under the
Edit menu. With ‘Multiple intervals’ the user can define two different sampling
intervals, and number of measurements within each interval. The recorder can, for
example, be programmed to switch between a narrow and a wider sampling interval.
This may be convenient for saving memory space in between. See chapter 8 about
multiple intervals.
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7.4 Connection

Choose the Settings menu and the Connection command. A dialog box appears:

) Connection Options &J

v Perform CRC test when retrieving RID

[V Check Data Echo in SNMS and updating settings in

Disconnect and Retrieve Data

[ Automatic data retrieval upon connection

Cancel

Figure 7.5 Connect and Retrieve Data Options

Perform CRC Test When Retrieving RID

The CRC test is a safety check performed by the software when retrieving Recorder
Information Data (RID). If the CRC test is not successfully carried out, it means that
some errors have occurred in the transfer of files or constants, between the recorder
and the computer. If a CRC test failure occurs, the user is notified. Normally, this
option should always be selected.

Check Data Echo in SNMS

Normally the Check Data Echo in SNMS and updating settings in Disconnect and
Retrieve Data should be enabled (figure 7.5). In case of communication problems
using a USB serial converter the user can try to disable this option, as it will bypass
data echo checks, resulting in less restriction on communication protocol.

Automatic Data Retrieval upon Connection

By enabling this option, the software will automatically check for data in the recorder
upon connection. If this option is not enabled, data retrieval is done manually by
choosing the ‘File’ menu, and ‘Retrieve Data’ command.
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7.5 Retrieve Data

Choose the Settings menu and the Retrieve Data command. A dialog box appears:

- S
I.) Retrieve Data Options i‘ - &J

Retrieve number of data according to:

¢ Last saved number of byte: 0
E quivalent number of measurements 0

" User defined number of byte

" The whole recorder memory: 261575
Recorder capacity:  Byte 261575
:Measurements 29062
0K

r,l,

Figure 7.6 Retrieve Data Options

Retrieve Number of Data

With default settings, the software retrieves the last measurement sequence recorded.
The user has the option of retrieving older data that is still in the recorder’'s memory.
By choosing the User defined number of data, the number of measurements
retrieved from the recorder can be set.

As the complexity of measurement intervals give incoherence in the calculation from
measurement number to the number of data byte to retrieve, the user has the option to
define number of bytes to retrieve.

If for some reason or another it becomes necessary to retrieve data more than once or
even several times, the previous DAD and MIT files are not overwritten before a
backup has been made. The backup files are in the same directory as the “original” or
the last DAD file.

A backup number system is in use that marks the first retrieved file as number one, the
second number two etc. The number sign #, is used to identify the backup up files.

Thus if a data file has for example the name 25M1106.DAD then the backup file, that
was the first retrieval, gets the name 1#25M1106.DAD, and the 25M1106.MIT file
that is associated with the DAD file, is backed up as 1#25M1106.MIT.
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7.6 View Data

Choose the Settings menu and the View Data command. A dialog box appears:

) View Data Definition C=nae &l

v View Data Trend (*.DAT) after Conversion

v “iew Data Trend [*.DAT) after Measurement Sequence Selection

v View Data Trend (*.DAT) after ReConversion
[T View Time Synchrone Data [*.TSD) after ReConversion

[T View Rate Of Change data [*.ROC) after ReConversion

Cancel |

— —_— 4

Figure 7.7 View Data

Select View Data Trend after data retrieval/conversion to view the data right after
data retrieval.

Select View Data Trend after Measurement Sequence Selection to work with
measurement data while offline.

With all the options in SeaStar, the user may want to do a lot of reconverting
(<File\Reconvert Data>) on data files after defining the preferences; changing units,
data formats, OOR settings, TSD settings, ROC settings, offset settings and
converting different sections of the data file, all of which result in numerous files. To
ease the task of remembering settings and results and/or renaming and copying files,
a backup system of reconverted files has been implemented.

A reconvert number is now associated with each sequence. This number is saved in
the recorder’s INI file and updated each time a reconvert is implemented. A copy is
made of the DAT, CIT, DAB, OOR, TSD and the ROC files with the reconvert number
attached to the filename.

Thus if a data file is for example named 5M1024.DAT, then after the first reconvert, a
copy of the DAT is named 1-5M1024.DAT, and the same naming convention is
applied to the other files.

Each time data retrieval is performed, a subdirectory, which name is the sequence
number, is created in the data directory, where a copy of the “original” DAT, DAB,CIT
and OOR files is placed. These files have a “0-" in their names. All the reconverted
files are placed in the sequence directory. The reconvert number system is optional,
and the user can disable it in the reconvert menu. When the reconvert number system
is in use, and when viewing trended reconverted data, the reconverted “backup” file is
displayed, thus eliminating the need to close the “last” converted trend data window.
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7.7 Out Of Range

If measurements are outside the calibrated range, they may seem inaccurate. The out
of range measurements are shown in the OOR file (View — Measurement Data — Out
Of Range Data). The min. and max. calibration points are given in the RID file, and in
this case it should be sufficient to go directly to ‘Edit — Reconvert Definition — Data
Definition’, and choose ‘RID values’ under ‘Out of range decimal values settings’.

Data is then reconverted by choosing ‘File — Reconvert Data’. See chapter 9 for more.

The user can also define the ranges. Choose the Settings menu, Out Of Range - UV
and DV definition command. A dialog box appears:

.} Set Temperature OCR parameters |E@éj
Decimal values (1-4094) Unit values
Min Max Min Max
Temperature 50 ;I |4050 ;} |'5 ;l [55 ;’ (-10 - 120 *C)

Default
Cancel Previous

Figure 7.8 Set Temperature Out Of Range (OOR) Parameters

Decimal Values

Decimal Values (DV) are raw measurements, sometimes referred to as binary data.
The decimal value is between O and 4095, which is the range for the 12 bit AD
converter. The decimal values are the recorder’s calibration range. The user should not
define the decimal value range, unless he has obtained these values for that particular
recorder from Star-Oddi.

Unit Values

The decimal values are converted to Unit Values (UV), for example a decimal value of
2000 could give 20°C. The user can select a specified range for temperature and
pressure. If unit values in the data are outside the measurement calibration range of
the recorder, the user has the option to set a max and min range for these unit values.

After selecting the unit value ranges and pressing the OK button, the following
window appears:
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QOR Correction LJ&
DV-Correction UV-Correction
¢ No Correction ¢ No Correction
(" Last Value (" Last Value
" Max/Min DV-imits " Max/Min UV-imits

Cancel |

Figure 7.9 Out Of Range (OOR) Correction

If no values have been selected for the Decimal Value (DV), no correction should be
selected. If Unit Values (UV) ranges were specified, the user has the option to change
the out of range measurements to the last value that was recorded before the out of
range measurement was recorded, or have it according to the max/min unit value as
specified earlier. In this case the software will know if the value is under the minimum
or maximum limit. After the correction has been made, the data needs to be
reconverted under File — Reconvert Data, and data will be changed accordingly.

7.8 Time Synchronize Data (TSD)

Choose the Settings menu, TSD definition command. A dialog box appears:

Time Synchronous Data Settings &J

[~ Make TSD file when converting DAD -> DAT

Sample Interval
{¢ 1Hour

" 10 Minutes
(" 5Minutes
" 1Minute

[ Indude empty cells

Cancel

Figure 7.10 Time Synchronous Data Settings

If the user wants to time synchronize two or more data files, it is possible to select
three options: 1 hour, 10 minutes, or 5 minutes. The restriction is that the sampling
interval selected must be greater than the initial interval, and it must also be dividable
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by the initial interval. For example, if the initial interval was 15 minutes, only the 1 hour
option can be selected for time synchronous.

If the ‘Include empty cells’ is enabled, the data tables will be empty for those
measurements in the original file that are not to be shown.

If the user wants to activate this feature, the ‘Make TSD file when converting DAD-
DAT' must be enabled. For changing the current measurement file with one of the
three intervals, the data must be reconverted by ‘File — Reconvert Data’.

7.9 Rate Of Change (ROC)

This new feature gives the user a chance to see how fast the signal is changing, i.e.
the estimated velocity of the signal. This applies to all measured parameters. The
ROC is calculated via a two point numerical differentiation:

ROC= (P2-P2)/(t2-t1)
P: Parameter expressed in a user defined unit
t: Time (hour, minute or second)

The way the ROC is set up and viewed is very similar to the TSD.
Under ‘Settings\ROC' the ROC options can be set:

Rate Of Change Data Settings Lii-_J

v Make ROC file when converting DAD->DAT

Time Unit Selection
" hour

¢ minute
" sec

{" no unit (constant = 1)

v Units are expressed with a prefix milli (E-3)

Cancel

Figure 7.11 ROC Definition

The ROC is only computed when a DAD->DAT conversion is performed, and when
the user wishes. The time units are selectable as hour, minute or seconds. For small
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changes it can be convenient to express the ROC as a milli (10°%) unit. For example if
the depth is in meters (m) then millimeters are expressed as (mm).

The ROC can be viewed as a trend under ‘View\Data Trend and Table\Rate Of
Change (ROC)' or as tabulated data via ‘View\Measurement Data\Rate Of Change'.

7.10 Chart

Title
To change the title of the chart, click on the title name. A dialog box appears:

r ~
Chart Title |

Enter New Chart Title:

|

OK | Cancel |
A

Figure 7.12 Chart Title Dialog Box

The chart is automatically assigned the data file number as a chart title. To change the
chart title, enter a new text string and press the OK button.

Time Axis
To change the time scale of the chart click on the X axis. A dialog box appears:
i () Axis Settings m‘&r
Title:

Scales

vV Automatic
vV Au ik l 3.12.2004 10:40:01
vV Au nge Mi l 13.4.2003 00:00:01

0K I Cancel |

A

Figure 7.13 X-Axis Settings Dialog Box
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By disabling the Automatic option, the minimum and maximum time values become
active. By clicking on the Change buttons for the maximum and minimum values, the
time range can be specified. By enabling the Automatic option, the measurement time
will go back to the initial range.

Value AXxis

To change the scale settings for the value axis, click on the Y axis scale. A dialog box
appears:

r T B
() Axis Settings | = =] [—é&-
Title: Im
Scales
v Automatic

% 27,736
% 2,402

0K l Cancel |

A

Figure 7.14 Y-Axis Settings Dialog Box

By disabling the Automatic option, the minimum and maximum measurement values
become active. By clicking on the Change buttons for the maximum and minimum
values, the temperature range to be shown on the chart can be specified. By enabling
the Automatic option, the temperature will go back to the initial range.

7.11 Chart Editor

The Chart Edit button (on every graph) gives access to the Chart Editor, a multi-
option menu, now with a Tree View interface, as can be seen in figure 7.15.
There are five main branches on the tree:

Series
Chart
Data
Tools
Export

The tree menu gives access to the same features as the tab menu described in the
user's manual. Most of the changes invoked are viewable immediately.
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All format and style changes made to the chart, are lost if the data are viewed again or
“Reconverted”, as the *.DAD and the *.DAT file are not affected by changes made to
the chart or the database.

Series

The Series window offers the same features as the “Active Series List” button.

& | Edit chart

Temperature(*C)
TirneLine k@ ¥ — Temperature(®C)

= Chart iy
-
+- Axis k@ =

+- Titles
Legend
Panel
Paging
+- Walls
Data
+- Tonls
Exporkt

Close

0 LEEE

Figure 7.15 Chart Editor

When a particular series is selected, like the Temperature series for example, a two
tab menu is revealed, as seen in fig. 7.16, where the user can “format” each series,
and set “points” in the graph. The tab “Point” offers visibility to points as the “Data

Point Marker” button on the graph, plus formatting of the points.
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=] Series

TimeLine
= Chart
+- Axis
+- Titles
Legend
Panel
Paging
+- Walls
Daka
+- Tools
Export

Temperature(®C)

|Temperature{°c)

Forrnak IPDint ]
Border..— | [ Dark 3D
Color. . . Jll | [ Color Each
Patkern. .. |vw Clickable

Height 30: [0 :II

Stacks  Mone

Il
i

Treat nulls:  Donk Paint

j h@ Line: Temperaturel®—

[v Color Each line

Gradient, [ ]

1l

Close

Chart

Figure 7.16 Format Series

The chart branch has six sub branches

AXis
Titles
Legend
Panel
Paging
Walls

AXis

There are 8 axes in a normal SeaStar chart, the number in use depends on the
recorder type. The Left Axis and Custom 1 axis are always in use, the latter is reserved

for the timeline.
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=/ Series ~| Scales | Thle | Labels | Ticks | Grid | Posiion |
Temperature{*C)
TimeLine Opkions ]Minimum ] Maximum ] Increment ]
= Chart v Autommatic
= Bxis
v Visible [ Inverted
Right &xis
Top Axis [~ Logarithmic
Bottom &xis
Depth Right Log Base: -
Depth Top
Custaom 0
Cuskom 1
+|- Titles
Legend
Panel
Eaninn b

Close

Figure 7.17 Axis Formatting

Figure 7.17 shows a six tab Axis menu. There are numerous options, some of which
can drastically change the behavior of the graph. The Minimum and Maximum tabs
give options similar to the menu offered when clicking an axis on the graph, the ticks
tab gives access to enable and disable gridlines, just as in the “Horizontal gridline”
and “Vertical gridline” buttons in the graph.

Titles
The Titles menu shown in figure 7.18, gives access to 4 tiles, each title a multi line text

window, which can be positioned anywhere on the chart. There are multiple formatting
options, six tabs, for each title.

- Series - Titl
-
Temperakura(=C) e
TimeLine
5 Chart Style lPDsitiun] Farmat ] Baorder l Text ] Gradient l Shadow l Picture ]
+]- Axis [v Wisible: |v Adjust Frame alignment:  Cenker hd
g
Title: L=
SubTitle 1T2420D4T
SubFook
Fooker
Legend
Panel
Paging
+- W alls
Data 4
Edi...
+ Iu:uols . "

Figure 7.18 Title Menu

Legend

The legend menu (see figure 7.19) gives the user an option of showing a series
legend.

The 8 tab menu gives options in styling positioning and formatting the legend.
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= Series | Style IPnsitinn ] Symbals ] Tite ] Forrnak ] Eiorder ] Text ] Gradient ] L L
Temperature{™C)

TimeLine

[ Visible Legend Stvle:  Autormatic -
=l Chart =

+]- Axis [~ Inverted Texk Skyle:  Left value -
—I- Titles
Title | Eont Series Calor Wert, Spacing: |0 j‘
SubTitle
SubFook Mo check boxes - Dijviding Lines. .. |
Foaoker
Legend
Panel
Paging
+- Walls
Data
+- Tools

-

Close

Figure 7.19 Legend Menu

Panel
The Panel menu (see figure 7.20) offers panel format options. Images, pictures and
icons can be imported onto the panel as a back image.

—I- Series | Colar lBorders l Margins] Gradient ] Shadow l Irage ]
Termperakure(C)
TimeLine Color...[]
=1 Chart
+- fis [ Default
|- Titles
Title
subTitle Iv Back Image Inside
SubFook
Footer
Legend
Paging
+- walls
Data
¥ "I_'nols .

Figure 7.20 Panel Menu

Paging

With the Paging menu, shown in figure 7.21, the data series can be chopped into
pages, with a user defined number of points per page. Only one page is shown at a
time, and the user can scroll through the pages via the page buttons, that appear (are
enabled) on the chart to the right of the Edit Chart button, when paging is selected.
Paging can be useful for viewing distinct time periods, one at a time, days or hours for
example. No offset is offered and sampling periods and start time can limit the
usefulness of this option.
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% Edit chart X]

- Series -~

Termperature(®C) Paoints per Page: |0 j‘ v
TirneLine ,
= Chart W Current page Legen

+- Bxis v Scale Last Page
| Titles

Title [~ Show Page Mumber $

SubTitle [ Auko scale axis
SubFoot
Footer
Legend
Panel
Paging
+-Walls
Daka
+- Toals

=

Page 1 of 1

Close

Figure 7.21 Paging Menu

Walls

The walls menu, as seen in figure 7.22, gives access to configuration of four walls, but
as SeaStar charts are default defined as 2D, only the “Back” wall is visible

TimeLine - . . =]
5 chart v Wisible Walls Sieze: Jo
+| Axis
Left i
) Titles |R|ght ]Bottnml Back, ]
Title Calor... [ [ wisible
SubTitle
SubFook Border... — [
Foater
Legend Pattern... [ Auto Hide
Panel
Faging Gradient... ]| [ Transparent
Left Paosition: , =
Right start: [0 = Size: [0 =
Eattom ﬂ 7 0 =]
. 5 ransparency: =
Back 2 End: |100 = =1

Figure 7.22 Walls Menu

The Walls menu, has similar options as the Panel menu, when defining a pattern, via
the “Pattern...” button, an image can be imported and placed on the wall. In fact, as
the Back Wall lies “on top” off the panel, a pattern or an image can enhance an image
on the panel, or the image on the panel can be seen through the wall with the
Transparency option.
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Data

In the data menu, seen in Figure 7.23, gives the user access to the database, upon
which the chart rests. Here text labels can be set to each measurement point.
Changes can be made to the time and measurement values. Changes made to the
data, are included when the data is exported, but if the data are viewed again or
“Reconverted” all changes are lost, as the *.DAD and the *.DAT file are not affected by
changes made to the database.

s Edit chart 3
- Titles. 2 — Temperat TimeLine =
;E:fTitle # Text k3 i ® i
=ubFoot o [Ios 12:00:00 23,72 108 12:00:00 219
Foater 1 W& 12:01:00 23,72 )08 12:01:00 219
Legend 2 & 12:02:00 23,72 08 12:02:00 219
Pl 3 & 12:03:00 23,72 08 12:03:00 219
Paging 4 W& 12:04:00 23,72 )08 12:04:00 219
5 wialls 5 W& 12:05:00 23,71 )08 12:05:00 219
Left 5 & 12:06:00 23,71 08 12:06:00 219
Right 7 W& 12:07:00 23,71 08 12:07:00 219
Battom 5 0% 12:06:00 23,71 )08 12:08:00 219
Back 9 & 12:09:00 23,71 08 12:09:00 219
10 W& 12:10:00 23,71 )08 12:10:00 219
+- Tools 11 W& 12:11:00 23,71 )08 12:11:00 219] ™
Expoark 3 . - A :_1 X I-_D

Figure 7.23 Data Menu

Tools

Under 'Tools' you will find several options to customize the setting of the cursor and
the appearance of the graph, such as page numbering, font, font size etc. To
active/deactivate the chosen setting check/uncheck the 'Active’' box on top of the first
page of this menu.

—I- Series -~ )
Temperature(*C) fdd... ‘ Delete | v fctive: ¥
TirmeLine
= Chatt R Cursor Series: TimeLine -
+- fis Page Murnber =
+- Titles Age Rectangle oIe lSnap ] Mouse]
Legend = Mark Tips Pen... —
Parel i
Paging Skyle:
+- Walls -
Data Wertical hd
= Tools Horiz. Size: Vert, Size:
Cursar
=T =T
Page Mumber i =1 . =1
Rectanlgle Scope Size! Scope style:
_ M?rleps 2 P [ -

Figure 7.24 First Page of Tools Menu
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Export

Under the Export menu, three tabs offer as many menus for saving data as

Pictures
Native (data)
Data (file)

Pictures
Figure 7.25 shows options when saving the chart as a picture to a file, or copy the
picture to the clipboard. There are seven format possibilities.

e Metafile
e Bitmap
e JPEG
e GIF
e PDF
e VML
e SVG
Titles Picture lNative] Data |
Title Farmat Cipki i
SubTitle a5 Mt afile s |see |
SubFoot as Bitmap
Fooker as JPEis v Enhanced
Legend as EE)'I:: -
as
Panel a5 VML (HTM)
Paging as WG
= Walls
Left
Right
Batkaorn
Back
Daka
+- Tools
Expark Copy | Save... | Send... |
v
Figure 7.25 Export Menu: Picture
Native

The Native menu, see figure 7.26, data is saved as “Native” *.tee chart files. Import of
these files is not supported in SeaStar at the moment.
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Data

= Titles
Title
SubTitle
SubFook
Fooker
Legend
Panel
Paging
= Walls
Left
Right
Batkon
Back
Data
+- Toals

Ficture  Mative |Dats |

[v Include Series data

Farmat:
{* Binary
™ Text
ML

[ File size: 7

[ |

| Save... |

Send. .. |

Close

Figure 7.26 Export Menu: Native

Data can be exported to files in four formats, see figure 7.27.

Text file (.txt)
XML (.xml)
HTML (.hml)
Excel (.xIs)

|- Titles
Title
SubTitle
SubFonok
Foaoter
Legend
Panel
Paging
= alls
Left
Right
Baokkorn
Back

Ficture ] Mative Data
Series:

[all})

Farmat:

f* Text

£ EML

" HTML Table

" Excel

Include:

[ Point Index
v Poink Labels
v Header

[ Paint Calors

Delimiter:

Tah -
Text Quates:

Copy Save,..

Send. .. |

Close

Figure 7.27 Export Menu: Data
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There are four Include options:

1. Point Index
The point index is the same as the measurement number, but offset by -1, as it
starts in O instead of 1.

2. Point Labels
If the user has added text labels to points in the DATA menu, these can be
included.

3. Header
The same headers as are in the DATA menu.

4. Point Colors
This option is not relevant in SeaStar.

Another method for exporting is to use the Alt+PrintScreen keyboard buttons to copy
an image of the SeaStar window to the clipboard, thereafter to paste it to another
Windows application. When a dialog box is open, then only that frame is copied to the
clipboard.

To copy a part of a data file, for example from a DAT file, then highlight the part you
want to copy and use the Ctrl+C keyboard buttons to copy the data snippet to the
clipboard. Then use the paste-option in another Windows application to transfer the
data from the clipboard.

SeaStar 4.3 - Starmon mini - 12420 - C:\DOCUMENTS AND SETTINGSVALL USERS\DDCUMENTSISS DATAISTARMON MININT2420 [ (=)
Fle Edit Recorder Settings Wiew ‘Window Help

NGSWA ] MEN 4
:ADOCUMENTS AND SETTIN R MENTS\SS-DATA AINIVT24 4 o =ES
C:ADOCUMENTS AND SETTINGSWALL USERS\DOCUMENTS\SS-DATANSTARMON MINNT242011T242... [2 B[] X!

20, MIT -~

Estinated battery life o
At iniviation cime (%) : 98

AT commection Cime
Renaining no

w
€

Meas.seq.no: 1 Com

Figure 7.28 Highlighted Text to be Copied
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7.12 Timeline

The timeline is a graphical viewing aide. Every time a file is loaded for trending, an
extra time value is calculated for every measurement point. These time values form the
Timeline. The Timeline is an extra series that follows the rules of the other
measurement series. When the graph first appears, the Timeline is inactive.

By selecting the Timeline in the Series List (see fig. 7.29), the Timeline becomes
visible as shown in figure 7.30.

Series List

B

Ok

@ W — Temperature[*C)
@ I Timel ine

Figure 7.29 Timeline Selection

B[ | B
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13.07 00:00 26,07 0000 0208 00:00
Measurement tine: 12.7 2005 - 2.8.2005
Statistcs for Temperaturel T}

Max: 2961 at 27.7. 2005 12:00:00

Fig. 7.30 Timeline on a Graph Showing “Day of the Year”

Min B,07 at 13.7 2005 17:00:00

Average: 15,35
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The Timeline is defined under Settings\Preferences\Timeline.
There are several options for the Timeline, as can be seen in fig. 7.31.

' Gy
Timeline Definition lﬁj

Define Timeline

* Day of the Year (1-365)
~ Month of the year (1-12)
" Week of the year (1-52)
" Day of the month (1-31)
" Hours of the Day (0-23)

-~

OK Cancel |

................................

Figure 7.31 Timeline Options

There is no need to reconvert the data, as every time a data file is loaded the Timeline
is calculated in accordance with Timeline settings. The Timeline is not a part of the *:
DAT or the *.TSD files. If the data is exported (see the Export section), then the
Timeline (if selected) will be included. Thus, the Timeline can also be used for
statistical purposes.

7.13 Templates

There are two scenarios where templates come in handy:

1. When many recorders are programmed with the same settings (multi mode),
and circumstances are in a way that the user cannot complete the setup of all
the recorders in one session, and he has to exit SeaStar (to continue later).

2. When the user wants to reuse, partly or completely, presumably a complex
and/or lengthy measurement setting.

Saving a Template

The user can now, when editing New Measurement Settings (NMS), save his work by
enabling “Save this NMS as a Template (file)” option (see fig. 7.32), before
acknowledging OK from the Edit NMS menu. Having selected this option and the
NMS are OK, the user has an option to write a description for the template (see fig.
7.33). Canceling this option cancels the ‘save template’ operation. The template is an
INI file and saved in the SeaStar\NMS directory. The name of the file is
MST<date><type letter>time<Interval mode=>.INI.
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) Set New Measurement Sequence

l = i =] .lIESIIJ

Set start time

Start date:

; -
Start time: churll4 _v_l Min

Set measurement interval time

Hours

Minutes

Seconds

Set Mode
¢ Single mode

" Multi mode

oK

9.11.2010 'l

0

TE|
OlE|

[~ Save this NMS definition as a Template (file)

ik

-
v

Use Template
Use Default

Previous

Fig. 7.32 Template Options in Edit\New Measurement Sequence

Save NMS as Template

Template Name: MST9112010T171004SI

Template Description: |

Cancel |

Using a Template

Figure 7.33 Saving NMS as a Template

Templates can be retrieved at a later time to be used directly or modified. The list of
templates is kept in the SeaStar\templets.ini file.
There are three buttons in the Edit NMS window, see fig. 7.32. The top button is used

for retrieving a template.

As can be seen in fig. 7.34, templates are selected via template name or description.
Parallel to selecting a template, descriptions can be edited and eventually templates

deleted.
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The recorder type and interval type, which the template was based on, are visible for
each template.

) Select Template ‘ SN X

Template list
Templet name

Description |3 - No description L}

Interval Type Primary Recorder Type

Single Interval Starmon mini

Edit description
Delete templet

0K ‘ Cancel

Figure 7.34 Template Selection

Templates can be used across recorder type boundaries and interval types.
Things to keep in mind when selecting a template are:

Single interval templates converted to a multiple interval NMS. All seven
intervals are the same.

Multiple interval templates converted to a single interval NMS, set the interval
as interval one.

Start time in the past is not allowed as will be apparent when exiting the Edit
NMS window.

Some recorder types are less compatible than others, an example of that is a
DST milli template converted to a DST GPS NMS.

After selecting a template, the user is returned to the edit window. If the selection is
not as what the user expected the “Previous” button will return the previous setting.

The user has one more option to quickly set up the NMS. The button in fig. 1, marked
“Use Default”, will return default NMS settings. The button can have four descriptions
and return four different settings depending on the status of recorder and
measurement selection.

PWNE

Use Default: No recorder selected.

Use Recorder: Recorder selected but not a measurement sequence.
Use Sequence: Measurement sequence selected.

Use Online: Recorder is on-line.
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8. Multiple Intervals

SeaStar has the option for setting up more than one sampling interval within a
measurement sequence. Reasons for wanting multiple intervals can be to save
memory, but still be able to have frequent measurements in between.

Choose the Edit menu and the New Measurement Sequence Definition command.

Select Multiple Intervals and the following dialog box appears:

(.} Set New Measurement Sequence

==

Set start time

Start date:

Hours

Minutes

9.11.2010 vl

Start time: Houl|1"' _v_l Min |12 _v_l

Set measurement interval time

1. interval 2. interval

|0

S OE

|0

S e

Seconds I 10 ;I | 10 ;I

Set mode

¢ Single mode

" Multi mode

No. meas. llOOO ;J |1000 ;J

Use Template
Use Default
Previous

[ Save this NMS definition as a Template [file)

Figure 8.1 Multiple Interval Selection
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8.1 Start Time

The user defines the date and time when recordings should start.

8.2 Measurement Interval

The first and the second interval is defined. Number of measurements must be defined
within each interval. The recorder will first take the defined number of recordings
within the first interval, and then shift to the second interval to record the defined
number of recordings for that interval. The recordings will shift between two intervals
and continue until memory is filled or connection with recorder is establised.

8.3 Set Mode

The option for ‘Multi mode’ is to enable the user to fix the settings, in case many
recorders are being programmed with the same settings. When the ‘Multi mode’
option has been selected, the same settings will automatically be downloaded into the
following recorders that connection is made with.

The Use Template can be used if older definitions have been saved by enabling the
‘Save this NMS as a template (file)'. That way it's possible to get templates that have
been set up in the past. With the Use Sequence button it is possible to get same
settings as from other recorders, by browsing for their serial no. By hitting the
Previous button the settings go back to previous, before changes were made.
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9. Reconvert Data

In SeaStar you have the option of reconverting data that has already been retrieved.
After re-defining parameters, the data is reconverted by ‘File — Reconvert Data’. The
main reasons for reconverting data are:

e Incorrect PC-time at measurement start-time.

e Need for temperature unit alteration.
Need for data file format alteration.

9.1 Data Definition

By choosing the Edit menu and Reconvert Data Definition, a dialog box appears:

-

) Data Reconversion Definition I =ANeEs X
Set reconversion measurement sequence start-time Time linear adjustment
¢ No Linear Time Adjustment
20 3 2
Start date: |‘0' 32009 _v_l . ) . .
" Linear adjustment time (min] 1
. TRE B Time span (days) 1
Start time: Hour v Min 7= |+
MID def. | Previous |
In reconversion use measurement intervals from In reconversion use constants from
e - I i
& Interval definition in MID file SR
P ’
¢~ Current new measurement sequence definition A b
" RBD file
Convert number of data according to: Out Of Range Decimal Yalues Settings

& Allthe data in the DAD file & Full scale (No boundaries)

" User defined number of data

From measurement number: 1 " User definition

To measurement number: 43582
" RID values

Comment :

Figure 9.1 Reconvert Data Definition

Set Reconversion Measurement Sequence Start-Time

If the user notifies from retrieved data that the date and clock are incorrect at the start
of measurements, then it is possible here to specify a new start date and time.
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In Reconversion Definition Use Measurement Intervals from

The measurement interval is either the interval settings as shown in the measurement
(MID) file, or if that interval is incorrect, a new and correct sampling interval is
specified in the ‘New Measurement Sequence Definition’ command in the ‘Edit’ menu.

In Reconversion Use Constants from

The user can choose to use calibration constants from:

e MID file. This option should normally be selected, as it contains information on
the constants from the measurement sequence.

e RID file. The recorder information file contains the same calibration constants
as the MID file, except if it has been re-calibrated. If it has been re-calibrated,
and the user wants to use the new constants on older measurements, the RID
option should be selected.

e RBD file. This option rarely needs to be selected. If the constants from the MID
and RID file are corrupt, the user should contact Star-Oddi for an RBD file.
See chapter A.3 for instructions on how to transmit the RBD files to the
recorder.

Convert Number of Data According To

You can reconvert all the data in the last measurement sequence, or you can define
the number of measurements to be reconverted. The user has the option to define
what measurement range should be reconverted (for example to exclude data points
when the recorder was above water).

Time Linear Adjustment

The real time clock inside Starmon has an accuracy of approximately +/- 1 minute per
month. This slight variation might accumulate over time and influence the
measurement results. To correct the gradual time shift first check ,linear adjustment
time" then type in the time offset value and the length of the measuring period.

Out of Range Decimal Value Settings

Measurements that are outside the calibration range are inaccurate, and may give
erroneous results. The out of range (OOR) measurements can be seen in the OOR
file. The user has the following decimal value out of range detection options when
reconverting:

Full scale (no boundaries). This means that literally no ‘out of range’ detection will be
made.

User definition. With this selection the range definition under ‘Settings - Out Of
Range - DV definition’ will be used. This option is selected when the decimal values
(DV) are not available in the RID file. This would normally require the user to contact
Star-Oddi for the decimal values.

RID values. The calibration decimal range is given in the RID file. This is the default
option and should normally be selected.
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If an RBD file exists in the \Seastar\RBD folder, then SeaStar recognizes this file as a
primary source for DV calibration range. In this case, the fourth option appears and is
set as default.

9.2 Temperature Definition

Under the Edit menu and Reconvert Definition, choose the Temperature Definition
command, and the following dialog box appears:

L) Temperature Reconvertion Definition 1 = El_l@
Temperature offset adjustment
" No offset adjustment

-

¢ Offset adjustment value [m°C] |0 2

-

Single spike correction

Ti
[ Use single spike correction me - jo sec :]'
[~ Slope correction Limit — [g

Dive: Temperature response shift

Start Point [1—_5; s!i?;gtr:gs

End Point |1 ] 2]
Linear estimation outside calibration range
[ Use linear estimation outside calibration
[~ Use at next data retrieval for this recorder
Nate: This overides 00R correction definition
I oK I Cancel |

Figure 9.2 Temperature Reconvertion Definition

9.3 Offset Adjustment

When Starmon mini recorders are used over a longer period of time the temperature
measurements can start to deviate from correct values. This is usually due to aging
and Star-Oddi recommends the recorders to be calibrated after 2-3 years.

When recalibrating, the battery can be replaced as well, so the recorders are good as
new. When checking older recorders, it has come apparent that the error in the
measurements is mainly due to an offset. Some users feel they can benefit from an
offset correction option in SeaStar, for example when a recorder has been in the
water for a long time and is later tested to show an offset.

To correct for a temperature offset, use the temperature reconvert definition menu.

Using the Settings menu and Preferences, you can also change the format of the
temperature unit and the data file. For reconverting the data, the data file must be
open. To start reconverting data according to the new settings, choose the File menu
and the Reconvert Data command. The data file is reconverted and conversion data
files are created (CIT, DAB, DAT). A new chart file is now open.
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Single spike correction

Check Use Single Spike Correction. There are two variables, Time and Limit. The
Limit defines how much difference can be between two points over a defined Time.

If a point is outside the range, +/- the limit of adjacent points. That point is then
calculated as the average of the adjacent points.

Temperature response shift

It is possible to set the desired start/end point to be shifted by X seconds. This shift
can only be performed on data with an interval of 1 second.

Linear estimation outside calibration range

Check this option to linearly estimate temperature measurements outside of
calibration range.

View Previous Conversions

Each time a reconversion is performed, a numbered file is created in the sequence
folder. To view previous conversions select a file under View and choose Previous as
can be seen in figure 9.3.

© SeaStar 500- DST centi- C3621 - CASEASTARWDSTCENTRG3621\ . e s
File Edit_Recorder Settings [View] Wizards Window _Help
Data Trend and Table Data file (DAT)
Recorder Information (RIT) ~ Time Synchronous Data (TSD)
Recorder Calibration Information (RCI) Rate Of Change (ROC) »
Recorder Download Information (RDT) Decimal (Binary) data (DAB) »
Text files (TXT,INLDAD,CCT,LMT, FPS,NMS)
SNMS Log File (LOG)
Measurement Data

Online measurements
SeaStar Log

|Display data in Chart and Table |Meas.seq.no: 3 [PowOn [Com1 |

Figure 9.3 Previous Conversions
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The window in figure 9.4 appears. Select a numbered file from the drop-down list.

1-3C3621.DAT

Figure 9.4 Select Previous Conversions

Reconvert Previously Retrieved Data

If data from the same sequence is retrieved more than once, a bookmarked data
sequence file (DAD) is created. These files can be accessed and reconverted by
choosing File-Reconvert data-Previous as can be seen in figure 9.5.

) SeaStar 5,00 - DST centi - C3621 - CASEASTAR\DST CENTIC3621\ (E=REEE >
e| Edit Recorder Settings View Wizards Window Help
New Recorder Type

(& Select Recorder »
& Select Measurement »

* Reconvert Data
(& Import Data File
& Print

x> Recorder Backup

Exit

|Reconvert datafiles to readable text files |Meas.seq.no: 3 [PowOn [Com1 |

Figure 9.5 Reconvert Previously Retrieved Data
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10. Recorder Modes

10.1 PC Mode

If the recorder is plugged into a PC computer with the communication cable, by
choosing the Recorder menu and the Connect command, the recorder is put into PC
Mode. At the bottom of the SeaStar window, the text On-line is displayed, indicating
that the recorder is on-line and in PC Mode.

While in PC Mode, the recorder will remain in an active listening stage. The
communication protocol is a simple master/slave arrangement, in which the recorder
is the slave. The slave will perform every command the PC issues, and after execution
of a command, it will return to listening.

10.2 Sleep Mode

The user receives the recorder in Sleep Mode, but it can easily be awakened by the
Connect command in the Recorder menu. The recorder is put into Sleep Mode when
the recorder is disconnected without putting it into Measurement Mode or by
choosing the Recorder menu and then Put Recorder in Sleep Mode. When the
recorder is in this mode, less power is depleted from the battery than in other modes.

Note: Older types of Starmon (up to Nr. 549) don't go into sleep mode automatically.
In this case select Recorder > Disconnect.

10.3 Measurement Mode

The recorder is put into Measurement Mode by choosing the Recorder menu, and
Start New Measurements Sequence. The recorder starts recording measurements
according to the start time (date/month/year) and sampling interval (hours/min.)
defined by the user.

When the memory is full, the recorder shifts automatically into Sleep Mode. Upon
connection and command from the PC, the recorder is put into PC Mode.
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11. Memory and Battery

11.1 Memory Organization

Data is kept in an EEPROM memory and will not be lost if the battery fails or expires.
The memory of the recorder is organized as shown in the figure below:

Data memory

—
=

-
N~

Settings —>

Unused memory/

ME T TES Old recordings

Figure 11.1 Data Memory Organization

When data is retrieved from the recorder, the following occurs:
1. The computer retrieves the data from the recorder and writes the data to the
computer’s hard drive.
The recorder has stopped recording, but still holds the recorded data.

When new settings are sent to the recorder, the following will occur:
New settings are sent to the recorder.

The data memory pointer is reset to the beginning of the data memory and starts to
write over older recordings.

The organization of the memory is now as follows:

Data memory

A/

<

Settings —>
Unused memory/
Old recordings

Figure 11.2 Data Memory with New Settings
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11.2 Battery Calculations

The voltage characteristics of the batteries used in our recorders make it almost
impossible to measure the energy available in the batteries, therefore we estimate the
energy consumption by calculation. All the energy consuming functions of the
recorder, like sleep, decay, running (microprocessor awake), measurements and
saving data are measured beforehand and used in our calculations. The calculations
are performed by the application software’s, SeaStar, Mercury and FoodStar. The
recorders themselves do not perform any energy calculations, but in order to start the
recorder in one computer and retrieve data in another while still having the battery
energy information, they carry the percentage of remaining energy with them in a
register file (in the RID). At the time the recorder is in production (when the battery is
new) the energy number is set to 100%.

Each time the recorder is started up in a new measurement sequence, the energy
consumption, since last sequence-start, is calculated and subtracted from the energy
number retrieved from the recorder, and this new energy-left number is downloaded
into the recorder.

The energy-left register in the recorder can be corrupted for reasons such as:

e The CRC check is turned off when connecting to the recorder and a
communication error occurs

e When a write error occurs when starting up a new sequence or updating a
status to the recorder and a reconnection is performed instead of performing
the operation again.

e Energy estimation calculations are not in accordance with actual energy
consumption.

To change/correct the battery energy numbers in the recorder refer to chapter 13.5.
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Starmon mini

12. Technical Specifications

Underwater temperature recorder

Measuring range

-2°C to +40°C (28°F to 104°F). Outside ranges
available at request

Average resolution

0.013°C (0.023°F)

Measuring accuracy

+/-0.05°C (0.09°F)

Response time

Plastic: Time constant is 18 sec. and final value (100%)
reached in 3 min. Titanium: Time constant (67%) is 6
sec. and final value (100%) reached in 35 sec.*

Memory size

350000 measurements**

Memory type

Non-volatile EEPROM

Data retention

20 years

Clock

Real time clock. Accuracy +/-1 min/month***

Sampling interval

Any value from: 1-99 seconds or 1min to 24hrs with
increments of 1 minute

First recording

At once or at any future time

Computer interface

RS-232C standard serial interface

Battery life 10 years****
Size Length 130mm, diameter 25mm
Wight in air Plastic version: 80g

Titanium version: 170g
Pressure Plastic version: 400m (40 bar)

Titanium version: 12000m (1100 bar)

*For a 40°C (104°F) temp. step response in stirred liquid.

*Memory size can optionally be increased to 524000 or 699000 measurements.
***The recorder automatically downloads the PC clock.

****Eor sampling interval of 10 min. or greater.

Specifications may change without notice.
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13. Wizards

There are four wizards in SeaStar:

13.1 Com Box Connection

Com Box é,
Connection
Check Yellow Light

Figure 13.1 Com Port Wizard

Choose the Wizards menu and the Com Box Connection command to enter the
Com Port wizard (see figure 13.1). The wizard goes through available ports and
activates them one at a time and asks the user to confirm that the communication box
displays a yellow light (see figure 13.2).

Com Port Wizard &J

COM1 7~
Did the yellow PC-com light turn on? - 4

. .

Figure 13.2 Com Port Wizard

13.2 Start Recorder

Choose the Wizards menu and the Start Recorder command to enter the wizard

(see figure 13.3).
Start Recorder éj

Recorder Type
Connection
Define Measurement Sequence

Start Recorder

Figure 13.3 Start Recorder Wizard
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This wizard starts the recorder with a new user defined measurement sequence.

13.3 Retrieve and View Data

Choose the Wizards menu and the Retrieve Data command to enter the wizard (see

figure 13.4).
Retrieve Data E’

Recorder Type
Connection
Retrieve Data

Start Recorder

Figure 13.4 Retrieve Data Wizard

This wizard retrieves data from the recorder and offers the user to start it again with a
new measurement sequence.

13.4 Quick Retrieve and Restart Recorder

Choose the Wizards menu and the Quick Retrieve command to enter the wizard
(see figure 13.5).

Quick Retrieve and ¥
Restart Recorder
Connection
Retrieve Data
Define Measurement Sequence

Start Recorder

Figure 13.5 Quick Retrieve Wizard

This wizard retrieves data from the recorder without graphically displaying it and offers
the user to start it again with a new measurement sequence.
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13.5 Change Battery Life
A new wizard has been added to the Wizards menu, the Change battery life wizard.

Choose the Wizards menu and the Change battery life command to enter the
Change battery life wizard (see figure 13.6).

Change battery Iifeél’

Recorder Type

Insert Recorder

Connection

Set New Battery Life

Write Battery Life To Recorder

Repeat Wizard

Figure 13.6 Change battery life

Select the recorder type and insert the recorder in the Communication Box. Once a
connection has been established a window appears (see figure 13.7). If the recorder
is already on-line then the wizard will start in step 4 (Set New Battery Life).

€ Set Battery Life [ - )

7~

Total sleep-time (weeks) 59 battery used (%) 34

Recorder definition: Battery life left (%) 04

(" Direct definition: Battery life left ( %) 64 | =

v

¢ Calculate from NMS, measurement weeks, and sleep time:
Calculate NMS Weeks measuring: 59| =
Estimated measurement battery usage pr. week (%) 0.77

Calculated total battery used ( %) 46
Calculated battery life left (%) 54

oK I Cancel I

Figure 13.7 Set Battery Life

The top line shows who long the recorder has been in use since (last) calibration, and
how much energy sleep and decay combined have used up over that time.

The second line shows Battery left based on the register in the recorder.
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There are two ways to set the battery life, Direct definition and Calculate from NMS.

Direct definition:

Check the Direct definition option and set the battery life (in %) manually based on
for example, the last known “good” value and an estimated/guessed value on energy
used since then. The user can also refer to other same type recorders working under
similar conditions.

Calculate from NMS:

Check the Calculate from NMS option and click on Calculate NMS. The user is now
transferred to the Set New Measurement Definition window where a sequence can
be defined. Once the measurement sequence has been defined an Estimated
measurement battery usage pr week (%) is calculated and shown in the Set New
battery Life window, note that sleep and decay energy use is included in this number.
Also the Calculated total battery used (%), which is based on the NMS definition
times number of weeks, plus the energy used by sleep and decay.

Now insert for how many weeks the recorder (since produced) has been measuring.
Each time the number of weeks is changed, the Calculated total battery used(%) is
recalculated, note that the Calculated total battery used(%) value will not show a
directly weeks * energy pr week, as the sleep + delay values must be accounted for.
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14. Group

Creating a group is a way to gather multiple measurement sequences which are part
of the same research project into one group. In a group the user can track when the
logger was started, the data retrieved and the data converted/reconverted. Groups
can be transferred to PatternFinder for further data analysis

-

() SeaStar 5.65 - DST tilt - C:\SeaStar\DST tilt\
File Edit Recorder Settings View Wizards Window Help

GF?U| New Group t
»

% Open Group

Send Group To |

Close Group J7

Figure 14.1 Group menu

New Group
Select New Group to create a new group. Please note that it is also possible to

create a new group by clicking the New Group button 5 in the group view pane.
The following window appears:

L) New Group @@ﬂ_hj
Name
Description
Cancel
L‘ /

Figure 14.2 New Group

Name the group and enter a description. The group file will be saved under the
directory: C:\SeaStar\Groups. Each group has its own subfolder where data files from
each sequence in the group are stored, this way the data can be accessed from
PatternFinder and Gna.
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Open Group
Select Open Group to open the Group directory. It is also possible to open the

directory by clicking the Open Group button = in the group view pane.

Once a group has been selected the group view pane appears:

Group View

QB ®

s Name: test®

‘‘‘‘ Created: 2012.04.11 15:51:
o Members

Figure 14.3 Group view

Adding sequences to group

To add a sequence to the group connect to a logger and define and start a new
measurement sequence. When starting the new sequence the following window
appears:

e

() Add Sequence To Gro... | = || & |||

Alias test 1

Description | test group|

OK Cancel

Figure 14.4 Add Sequence to Group
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Set an alias for the sequence and enter a description. Click OK and the sequence will
be added to the group (see figure 14.5).

Group View

Sl @®
Name: test

.B Description: test 1+

: Created: 2012.04.04 09:07:
=+  Members

E] _8 test 1

Recorder: US317

Sequence: 2
----- '3 Description: 10 min
Started: 2012.04.11
Retrieved: 2012.04.
DAB: OK
DAT: OK
MDD: OK
E] '3 test 2
Recorder: US317
Sequence: 3
3 Description: 5 min
Started: 2012.04.11
Retrieved: 2012.04.
DAB: OK
DAT: OK
MDD: OK

Figure 14.5 Group view pane

If a group is open when starting up a logger the new measurement sequence will be
automatically registered in the group. If no group is open the sequence will not be
registered in any group.

Retrieving data

When retrieving data from a logger and the sequence is already in a group the data
retrieval time is registered in the group. Also when the data is converted/reconverted a
copy of the *DAT file is stored in the group folder.

©2013 Star-Oddi. All Rights Reserved Page 77



User Manual SeaStar Graphic Supporting Software

Send Group To
Select Send Group To to transfer a group to another software.

i New Group
Open Group

4 Send Group To

Send To PatternFinder

Close Group

Members

Send To Gna

Figure 14.6 Send Group

It is also possible to transfer a group by clicking the Send Group to button @ in

the group view pane.

Close Group
Select Close Group to close an open group.

v
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Appendix

A.1 Directories and Files

Directory Structure

The user can choose between SeaStar's default data directory structure (path) or
define his own data path. As the SeaStar program is a multi recorder type program,
the directory structure branches from the directory where SeaStar is positioned down
to type directories, i.e. ‘Starmon mini’, ‘DST milli’ etc. From there it branches again into
recorder directories, named after the serial numbers of the recorders, designed to
hold data for each individual recorder (data directory). All in all it is a three level
directory structure.

An example of this directory structure for Starmon mini is:

C:\Seastar\ The installation directory, SeaStar.exe location.
C:\Seastar\Starmon mini\ The type directory for Starmon mini.
C:\Seastar\Starmon mini\TO801\ The directory for the TO801 recorder.

When connecting to a recorder for the first time, SeaStar creates the recorder
directory, named after the serial number of the recorder.

Information Files
SeaStar uses information files to store and retrieve settings. There are two types of
information files:
The type-INI files, (for example StarmonT.ini for Starmon mini).
The information type files are all in the installation directory, they contain
information on specific settings for each type.
The type-INI files for Star-Oddi products are:

StarmonT.ini Starmon mini
DSTm.ini DST milli

DSTr.ini DST milli recycle
DSTu.ini DST micro
DSTc.ini DST centi/centi-ex
DSTs.ini DST CTD
DSTg.ini DST GPS

The recorder-INI files, for example TO801.ini contains settings information and data file
positioning for the TO801 recorder. The recorder-INI files are located in the
appropriate type directory, i.e. all the Txxxx.INI files are in the ‘Starmon mini’ directory.

Files Locations

As stated previously, the type-INI files are placed in the ‘SeaStar’ directory, and the
recorder-INI files are placed in the recorder type directory. All other recorder and
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measurement related files created by SeaStar, are placed in the appropriate
recorder’s directory. For example: C:\SeaStar\Starmon mini\TO801\ is a directory for
the TO801 recorder and all files belonging to TO801 are placed there.

If the user whishes to use his own defined data path, for example C:\Data\, then all the
files for all the recorders, except for the INI files, are placed there. If the user has
enabled the “Create recorder directories” in the user path definition, individual
recorder directories, irrelative of type, are created under the user defined path, for
example: C:\DATA\TO801\ for the TO801 recorder. The TO801.ini file (located in the
C:\SeaStar\Starmon mini\) contains the path to the C:\DATA\TO801\ directory, and
all files related to the TO801 recorder will be placed in that particular directory.

Browsing for a Recorder

When browsing for a new recorder from the ‘Select recorder’ under the files menu,
the default method is to find a recorder-INI file in the type directory. The INI file will
then point to the data directory (the recorder’s directory). If the user has enabled the
“Browse first in the user directory” in the user path definitions, the search starts in the
user defined directory, where a *.RID file must be selected.

Recorder Related Files

Every file for Starmon mini that is recorder related has the following name format: Txxxx
- The name is the recorder ID (serial no.)

Ext Description File type
RID Recorder information data Binary
RIT Recorder information text Text
RBD Recorder backup data Binary
RDD Recorder SNMS* download information data Binary
RDT Recorder SNMS* download information text Text

*SNMS: Start New Measurement Sequence

The recorder ID (RIT) can at a later time be opened, and the related measurement
data can be viewed, printed and reconverted. The RDD, RDT and DIR are download
information files, created when a new measurement sequence is started.

Measurement Related Files

Every file that is specifically measurement related has the following name format:
mmmTxxxx - The name is the measurement number + serial no.

Ext Description File type
MID Measurement information data Binary
MIT Measurement information text Text
MDD Measurement download information data Binary
MDT Measurement download information text Text
CIT Measurement conversion information text Text
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DAD Measurement Data Binary file Binary
DAB Measurement Data Binary file Text
DAT Measurement Data Binary data Text

The MID, MIT and DAD files are created upon measurement data retrieval from the
recorder. The DAB, DAT and CIT files are created when converting the data. The
MDD and MDT are download information files and created when a new measurement
seqguence is started.

Data Files
Upon data retrieval, three main data files are created.

The *.DAD File

This file is the raw data source file. The data is in mixed binary form. The user cannot
access this file in the SeaStar program. When converting these raw data into
measurements, the *.MID file is needed. The result from the conversion are two data
files, the * DAB and the *.DAT.

The *.DAB File

This file contains sequential binary representation of the data in columns. The first
column is the measurement number. The other columns contain the measured
parameters in a binary form.

The *.DAT File

This is the actual result file, where the measurements are converted to their natural
units and timed. This is a text file with columns. The first column is the measurement
number, the second column the date and the time, depending on the set-up. The third
column is the time or the first measured parameter, depending on set-up. The
following column(s) contain the converted measured parameters with units and
number of decimals according to set-up. Number of parameters can range from 1-3,
and number of columns 3-6 accordingly.

Data Header

The *.DAT file contains a data header, which is a detailed description of how the
*DAT file is configured. This feature is used by SeaStar when graphically
representing the data, and is practical if the user wants to import the data into other
applications or databases. Most of these descriptive items are derived from the
‘Settings’ menu and the recorder type definition in the ‘File’ menu.

Each header item is contained in one line, and all header lines start with a #
(bookmark) and a number. Then follows a description of the header item, and then 1-4
directives, all separated by tabs. Eventually a comment trails the directives, preceded
by a semicolon (;).

The following is a description of the directives contained in the data header.
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Item

Description number of directives

#0

#1

#2

#3

#4

#5

#6

#H7

#8

#9

Date-time: 1
The date and time of that particular*.DAT file creation.

Recorder: 1
The recorder and sequence number, f. example 12T0801.
Used for confirmation and as a graph header.

File type: 1

Describes file column structure, mainly if Date and Time are joined
(0-3).

0: Result file  Number Date Time Channels 1-3

1: Result file Number Date & Time Channels 1-3

2: Binary file  Number Binary Channels 1-3

Columns: 1
Total number of columns (3-6).

Channels: 1
Number of measurement parameters (1-3).

Field separation: 1

Separation between columns (0,1).
0: Tab

1: space

Decimal point: 1
(0,1)

0: Comma

1: Dot

Date def.: 1
Date format (0,1)
0: dd mmyy

1. mmdd yy

Time def.: 1

Time separation (0,1)
0: Colon (3)

1: Dot ()

Channel 1: 4
Set as left axis, normally temperature. The four directives are:
Axis header, unit: Text
Column header, unit: Text
Number of decimals: (0-3)
Axis direction (1,2)
1 Ascending
2: Descending
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#10

#11

#12

#13

#14

Channel 2: 4

Set as right axis, normally pressure. The four directives are:
Axis header, unit: Text

Column header, unit: Text

Number of decimals: (0-3)

Axis direction (1,2)

1 Ascending
2: Descending
Re-conversion: 1
Definition on conversion / Extra header in graph (0,1)
0: Original conversion
1: Reconverted

No temperature correction: 1

Only in re-conversion, temperature correction in pressure calculations, is used
as extra header information (0,1).

0: Normal correction

1 Correction was disabled

Pressure offset correction:2
In pressure calculation, a zero offset can be adjusted. The two directives are:7
Applied: (0,2)
0: No adjustment was made
1: A zero offset was adjusted.
Adjustment value:  An integer value in mbar

Channel 3: 4
Set as extra right axis, normally salinity. The four directives are:
Axis header, unit: Text
Column header, unit: Text
Number of decimals: (0-3)
Axis direction (1,2)
1 Ascending
2: Descending
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A.2 Help Menu

Choose Help and the following window appears:

[ ) SeaStar 5.60 - DST centi-ex - C:\SeaStar\DST centi\,
User Manual
Troubleshooting

Release Notes

Check for Updates
Submit Ticket F1
About...

llHeIptopics [ PowOn |Coml | (/J

Figure A.1 Help Menu

User Manual
Select User Manual to open the Starmon mini user manual.

Troubleshooting
Select Troubleshooting to open the Trouble-Shooter.

Release Notes

Select Release Notes to view a description of the latest features added to SeaStar,
the date when they were added and a reference to the chapter number of each
manual where the additions can be found.
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Check for Updates

Select Check for Updates to manually update the latest version of SeaStar, User

Manual, Trouble-Shooter and Release Notes. The following window appears:

() Select files to download lé,l

[~ Application

Files Selected: 0
Total Size: 0,00 B

[~ SeaStar.5.24.zip (0,00 B)

Figure A.2 Select files to download

Select the files you want to download and click OK. The program downloads and
installs the latest updates to the software. Please note that this can only be done
when the program is offline i.e. when no recorder is connected to the program.

Change Log is displayed if a new application version is available while updating (see

figure A.3)

) Select files to download

]

[~ Application
[~ SeaStar.5.32.zip (2,67 M)

Files Selected: 0
Total Size: 0,00 B

I Cancel |

5.32
Major Changes
Minor Changes

Changelog is displayed if a new
application version is available while
updating.

Application file size is now correctly
displayed when updating.

Spelling errors.|

Active series now allows the user to right |

click and select: all, none, invert.

Low battery warning when starting a new
measurement sequence if the battery level
is below 20%.

Wizards: if multi mode is active then the
start new measurement settings is skipped
and if completed successfully offers to
repeat the wizard.

Wizards: Added a notification to remind

Figure A.3 Change Log

©2013 Star-Oddi. All Rights Reserved

Page 85



User Manual SeaStar Graphic Supporting Software

By selecting Settings-Update you can now choose whether you want to update
SeaStar manually, every X number of days or every time SeaStar is run.

Settings LJ%

Check for updates

" Manually

(" Every |30 |%] days

{* Every time SeaStar is run

Last check was 0 days ago

oK | Cancel

Figure A.4 Update

Submit ticket

Tickets can now be sent directly from the application to our support department by
selecting Help-Submit Ticket. A shortcut key, F1, can also be used at any time while
in the application and is especially useful when the menu bar is disabled.

In the ticket form (see figure A.5) you can add your name and email. Select a category
that best describes your problem and write a subject and description. If you like you
can select Images (screenshots) and browse for images in the screenshots folder
and send them with the ticket. By selecting Other files you can also add files to the
ticket. To automatically add recorder data use the Include Recorder Data option. By
default the following files are included: screenshot, system information, logs and
settings. These can be excluded with options in Other files.

To receive a response we require that you include a valid email address.
Tickets can also be created by e-mailing support@star-oddi.com with the problem
description and files attached.

If you want to add more information to a previously created ticket you can reply to the
support response.
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(.} Submit Ticket @
Name l Include Recorder Data
% None
Email l c
Z  AlRe
Category [T -] |

Message ]Images (screenshots) ] Other Files ]

Subject |

OK | Cancel |

Figure A.5 Submit ticket

About

Select About for general information about SeaStar.

A.3 Recorder Backup

When replacing the battery, new recorder sessions have to be transmitted to the
recorder. The user should contact Star-Oddi for a RBD file.The name of the backup
file is Txxxx.RBD (serial no. of the recorder plus the .RBD ending).

Downloading the backup file:

Copy the backup files (RBD) into the SeaStar RBD directory.
Open the SeaStar software.
Plug a recorder to the PC computer.

Select the 'File' menu and 'Recorder backup' command and the following window
appears:

P WNE

Select a recorder *.RBD file

Leita i- |13 RBD | £k Ef-
1] C4665.RED 1] K2348.RED 14 QO003.RED

1] C4795.RED 4] K2350.RED 14 S1523.RED

1] I0119.RED 1] K2351.RED 141 Y0677 .RED

1] K2336.RBD 1] ME411.RED

1] K2339.RED 4] ME419,RED

1] K2343.RED 13 ME452 RED

4] K2344,RED 1] 0000 1.RED

4] K2345.RED 4] QOO0Z.RED

Heiti hlutar: | ﬂ
Hiutir af gerd: |F|ecolder Backup D ata file(C* rbd) ﬂ Hastta vid

Figure A.6 Select a Recorder *.RBD File
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Browse for the correct RBD file on the computer and click OK.
5. Insert the sequence number and remaining battery life (see figure A.7). Note that if
the sequence number is set too low, data will be overwritten.

Set Sequence Number and ... §|

Seq. number from EBD file: 0

Input new sequence numbet: 10

Set battery hfe remaining (%4) 100
| QK | ’ Cancel I

Figure A.7 Set Sequence Number

6. The SeaStar software downloads the RBD file into the recorder and the window in
figure A.8 appears. Click OK.

Backup operation §|

The backup data are in the recarder \l)

The recarder iz Off-ine
Please connnect again |

Ok

Figure A.8 Backup Operation
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